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These release notes contain important information about this product release,
including the following: installation notes, details regarding known issues
with this release, and important information for current users.

Read the entire document before installing your Business Objects software,
and be sure to visit the Business Objects support web site for additional
notes and information that may become available following the release of
this document.

For acknowledgements of third party contributors and applications, in addition
to related license information, see http://www.businessobjects.com/solutions.

About BusinessObjects XI Release 2 SP3 and Productivity Pack

Depending on your requirements, the BusinessObjects XI Release 2 SP3
and Productivity Pack provides a number of installable packages.
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Silent installation options for reduced
Desktop Intelligence installation

The client tools silent installation allows you to deploy only the tools you
select, for example, Desktop Intelligence.

The following silent installation parameters were added to the
BusinessObjects Enterprise XI R2 SP3 client installation:
• NO_Samples allows you to exclude Xtreme databases from the Client

Tools Install.
• NO_Templates allows you to exclude Visual Studio 2005 templates.
• NO_Log disables the installation logging.
• NO_Webhelp excludes the WebIntelligence online help, InfoView Guide,

and administrator guides from the installation as these are not required
in a standalone Desktop Intelligence installation.

Each installation parameter, when set to 1 in a silent installation command,
excludes a significant component from the installation of BusinessObjects
Enterprise XI R2 SP3. When you use them all, the installation footprint of
the BusinessObjects Enterprise Client Tools is reduced to approximately
390 MB.

When used separately:
• NO_Samples offers approximately 100 MB of size reduction.
• NO_Templates offers approximately 10 MB of size reduction.
• NO_Log provides 50 MB of size reduction.
• NO_Webhelp offers approximately 200 MB of size reduction.

Each parameter can be used independently of or in combination with the
other silent installation parameters.

Installing BusinessObjects Enterprise in
a 64-bit environment

The steps for Installing BusinessObjects Enterprise on a 64-bit Operating
System are the same as installing on a 32-bit Operating system. Refer to
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the BusinessObjects Enterprise installation documentation (Windows or Unix)
for detailed instructions.

Note: BusinessObjects installations run in 32-bit compatibility mode in a
64-bit environment.

1. Install BusinessObjects Enterprise XI Release 2 Service Pack 2.

Note:

The installer does not allow you to install to a directory that has
parentheses "(" or ")" in its name. As a result, the default directory,
\Program Files (x86)\Business Objects, is invalid. Instead,
BusinessObjects Enterprise should be installed in the \Program
Files\Business Objects directory.

2. Log on to Central Management Console.
3. In the "Users" page, reset the administrator password.
4. In the "License Keys" page, enter a valid license key.
5. In the "Servers" page, select the BusinessObjects Enterprise servers

and enable them.

Note: If you are using Live Office, creation of Web Intelligence reports
is not currently supported in InfoView on a 64-bit Linux Operating System.

6. If necessary, import sample universes and/or sample Crystal Reports into
your BusinessObjects Enterprise system.

7. If you are using Crystal Reports and the database server is Microsoft
SQL Server 2005, ensure that you have the latest version of SQL Server
2005 Feature Pack installed to obtain the latest 64-bit Microsoft SQL
Server Native Client.
After installing the driver, you should set up your Microsoft SQL Server
2005 data source using the 32-bit ODBC Administrator.

Note: The ODBCDSNs displayed in the Report CreationWizard are only
32-bit ODBC DSNs. If you have a 64-bit database server, ensure that
you have installed the 32-bit ODBC data access driver that is supported
by your database server. If you have a 64-bit Oracle OLE DB data source
in your deployment, install the 32-bit Microsoft OLEDBProvider for Oracle.

8. Install BusinessObjects Enterprise XI Release 2 Service Pack 3 to update
your BusinessObjects installations.
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BusinessObjects Enterprise Support in a 64-bit
Environment

The following operating system/chipset combinations are supported for
BusinessObjects Enterprise and Crystal Reports installations:
• Windows 32-bit on 64-bit AMD/Intel chipset
• Windows 64-bit on 64-bit AMD/Intel chipset
• Linux (Red Hat and SUSE) 32-bit on 64-bit AMD/Intel chipset
• Linux (Red Hat and SUSE) 64-bit on 64-bit AMD/Intel chipset
• Sun SPARC 64-bit: supported for BOE*
• IBM AIX RISC 64-bit: supported for BOE*
• HP-UX on PA-RISC 64-bit: supported for BOE*

Note: *The data access drivers used by BusinessObjects Enterprise and
Crystal Reports must also be 32-bit, but the database server software,
operating system, and chipset can be what the database vendor supports.
On 64-bit Windows, you cannot mix 32-bit and 64-bit executables, so it is
not possible to use the 64-bit DB drivers.

Note: On 64-bit Windows, there is a 32-bit ODBC Administrator and a 64-bit
ODBC Administrator. Also, there are 32-bit ODBC registry and 64-bit ODBC
registries. If you set up a data source (DSN) using the default 64-bit ODBC
Administrator, that DSN will not appear for 32-bit applications.

The name of the ODBC Administrator application is called odbcad32.exe for
both 32-bit and 64-bit versions.

On 64-bit Windows, the ODBC Administrator is located in the following
locations:
• 64-bit ODBC Administrator: %SystemRoot%\system32\odbcad32.exe
• 32-bit ODBCAdministrator: %SystemRoot%\SysWOW64\odbcad32.exe

Installing on Windows 2003 64 bit operating system

When you install BusinessObjects Enterprise XI R2 Service Pack 3 on a
Windows 2003 64-bit operating system with .NET 1.1, and then open .NET
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InfoView or .NET CMC running off of IIS, you receive a 'Service Unavailable'
error.

In 64-bit Windows operating systems, 64-bit processes can only load 64-bit
DLLs, and 32-bit processes can only load 32-bit DLLs. By default, IIS6 on
64-bit Windows runs with 64-bit W3WP.EXE processes, but .NET Framework
1.1 as ASP.Net implemented through 32-bit ISAPI DLLs, so the W3WP.EXE
processes for IIS6 cannot load the DLLs for ASP.Net.

To fix this issue, run the following command to force IIS6 to run W3WP.EXE
as a 32-bit application in WOW64 (32-bit compatibility) mode:
CSCRIPT C:\Inetpub\AdminScripts\adsutil.vbs SET W3SVC/App
Pools/Enable32bitAppOnWin64 1

You need to restart IIS6. Use the following command:
NET STOP W3SVC /y & NET START W3SVC

Set Analyzer with 64-bit Windows Vista

Full Client Set Analyzer does not work with the 64-bit version of Windows
Vista.

MS SQL Server 2005 32-bit Native Client

MSSQL Server 2005 32-bit Native Client is not supported on 64-bit platform.

The license key is not added to the CMS during
installation

When you install BOE XI R2 SP3 on a 64-bit operating system, a valid license
key is not added automatically to the Central Management Console in CMC
> License Keys.

Workaround:
1. Log on as an administrator to the Central Management Console.
2. Go to CMC > License Keys.
3. Add the license key.
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MetaDataPlugin InfoObject permissions
If you are upgrading from BusinessObjects Enterprise (BOE) XI R2 SP2 to
BOEXI R2 SP3, youmay encounter an issue with the permissions associated
with the MetaDataPlugin InfoObject.

In BOE XI R2 SP2, only administrators were assigned view rights on the
MetaDataPlugin InfoObject. As of BOE XI R2 SP3 everyone has view rights
set for this InfoObject. Therefore if you are installing BOE XI R2 SP3, and
migrating the objects from your BOEXI R2 SP2 Central Management Server
(CMS), you may have a problem accessing the MetaDataPluginInfoObject.

Workaround:
1. Delete the MetaDataPlugin InfoObject from the CMS using the BOE SDK.
2. Restart the CMS.

The fonts.xml file is corrupted during
installation

In the Solaris version of Voyager, an error occurs when you click the "Print
to PDF" icon from a Voyager workspace. This happens because during the
installation of BOE XI R2 SP3, the fonts.xml file you customized in a previous
BOE installation is overwritten.

Workaround:

All files that are overwritten during installation are stored in a located in the
base folder {$INSTALL_DIR}/patch/sp3/backup. Restore fonts.xml from
this backup and use it to replace the installed version in the following location:
[$INSTALL_DIR]/bobje/enterprise115/
solaris_sparc/com/businessobjects/
multidimensional/services
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Uninstalling Live Office results in a
self-repair action in other BOE
applications

In Windows, launching applications like Crystal Reports, Business View
Manager and OLAP Intelligence, after uninstalling Live Office, starts a
self-repair action for review

After you uninstall Live Office and then launch either Crystal Reports,
Business ViewManager or OLAP Intelligence, a configuration screen appears
with the following message:

"Please wait while Windows configures BusinessObjects Enterprise XI
Release 2"

Caution: Do not select Cancel. The configuration process takes
approximately five minutes to complete, and then the respective application,
as well as other applications will launch without any problem.

The domain property of the
dsws.properties is not updated with the
CMS name and port number during
installation

BOE XI R2 SP3 does not automatically update the domain property. If the
Central Management Server (CMS) in not running on default CMS port, you
need to update it.

Workaround: Enter the port number with the CMS name in the domain
property of the dsws.properties file, then redeploy the dswsbobje.war file.
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Uninstalling as part of the service pack
sometimes causes an error to appearwhen
opening the CMC in Java

After uninstallation using BOE XI R2 SP3, an HTTP Status 404 error may
appear when you try to launch the Central Management Console using Java.

If this happens, try the following:

• Wait for Tomcat to redeploy the war file.

• If the problem persists, manually restart Tomcat.

• As a last effort manually redeploy the war files.
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Deploying BusinessObjects Enterprise
applications on the IBMWebSphere
application server

Business Objects recommends the following best practices for deploying
BusinessObjects Enterprise applications on the IBMWebSphere Application
Server.

Deploy your BusinessObjects Enterprise system by using one of the following
methods:
• the WebSphere installation tool
• wdeploy script
• manually

In each case, it is highly recommended that you deploy the WAR files in the
order listed:
• Webcompadapter

• jsfadmin

• jsfplatform

• admin

• infoview (desktop.war)
• adhoc

• styles

• analysishelp

• dswsbobje

• afhlep

Using the desktop.war file in a
distributed UNIX deployment of
Performance Management XI R2 SP3

If you install BusinessObjects Enterprise, without the Performance
Management components, on one directory and then install Performance
Management, without the BusinessObjects Enterprise components in a
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DIFFERENT directory, the desktop.war present in the Performance
Management directory is the updated desktop.war that contains both
BusinessObjects Enterprise and Performance Management. Because of
this, you cannot log into Performance Management.

Workaround: Redeploy to the BusinessObjects Enterprise Tomcat directory
the deskop.war in the Performance Management directory.

Error while setting up EPM servers on a
differentmachine than the CMS and .net
WCA

An "initconfig file doesn’t exist" error is returned when you log into InfoView
where there is an Expand installation on a secondary server in an
environment with the following configuration:
• Primary machine

• CMS
• cache server
• job server
• Java
• .Net WCA

• Secondary machine
• processing server
• performance management servers pointing to the primary machine

To avoid the error, do the following:
1. Create a folder named "Performance Management 11.5" under the

BusinessObjects installation directory on the machine where .Net WCA
is installed, and not on the box on which the performance management
servers are installed.

2. Manually deploy the war files, copying from the machine on which EPM
is installed.

3. Copy the Initconfig.properties file to the Performance Management 11.5
folder.
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The PMDT is not migrating metric
conditions

In Windows, the PerformanceManagement Deployment Tool is not migrating
metrics correctly, and the condition in the target system is set to none. This
occurs for all metrics created off a specific universe. If you refresh the metric
there is no filter applied and the resulting data for the metric is not correct.

Workaround: Move the conditions and filters from the universe to the same
class/subclass as the measure.

Security message appears in the Tomcat
SSL mode

In Windows, the following browser security message appears:

"This page contains both secure and nonsecure items. Do you want to display
the nonsecure items?"

In the following situations:
• when viewing a Crystal Reports report in Java and ActiveX Viewer in a

new full screen browser window
• while displaying dashboard analytics in Flash mode
• in InfoView with Apache Reverse Proxy server

This happens when the Secure Socket Layer (SSL) mode is activated in
Tomcat, and theUseMacromedia Flashwhen available option is activated
in InfoView Preferences > Performance Management. This is a bug in
Internet Explorer (http://support.microsoft.com/kb/184960).

Workaround:

You need to change an Internet Explorer setting:
1. In Internet Explorer, go to Tools > Internet Options > Security.
2. Select the appropriate zone for the server. If you don’t know the exact

zone, contact your network administrator.
3. Click Custom Level.
4. Under "Miscellaneous", enable "Display mixed content".
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In VS2003 WebApplication designtime
and runtime, the toolbar and charts show
up as a red X

In Windows with .Net, when you use VS2003 WebApplication designtime,
the toolbar show up as red X's. In runtime, the toolbar and charts show up
as red X's.The folder and files of crystalreportviewers115 do exist and its
path is correct.

BusinessObjects Enterprise XI R2 SP3 patch installer does not alter IIS
metabase settings.

Workaround:
1. Delete the virtual directory of crystalreportviewers115 in the IIS.
2. Recreate it with the same name, and point to the following path:

[BusinessObjects installation
directory]\Common\3.5\crystalreportviewers115

3. Run iisreset in the command prompt.
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Configuring SQL generation parameters
for a universe in the Data Access Guide

In the Data Access Guide, in the Configuring SQL generation parameters
for a Universe, Parameter file structure section, the following information is
missing or incomplete from the Functions file section:
• Information on the Functions section is incomplete.

The Functions section can only contain four arguments. That is, under
theArguments section, you can include up to fourArgument items only.

• There is no information included for the Group parameter.

The Group parameter can have a value of True or False:
• A value of True sets that that the function is a group or aggregation

function, and in this case, the SQL generator generates a GROUP
BY clause.

• A value of False sets that that the function is not a group or
aggregation function.

• The information on the ID subsection states that the ID is the name that
appears in the Designer function list.

In Designer, the function's formula appears in the function list. In Reporter,
however, the IDappears in the function list.

• The information on the InMacro parameter states that when the value is
set to True, the function is listed in the Object’s Edit Select box in
Designer.

The InMacro parameter does not have any effect in Designer. It does,
however, have an effect in Reporter. In Reporter, if the InMacro value is
set to True, then the function is listed in the User Objects function list.
If the value is set to False, then the function is not listed.
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Locked resources parameter in the Data
Access Guide

In the Data Access Guide in the Creating a connection with the New
Connectionwizard, What parameters are set in the New Connection wizard
section, it states that the Locked Resource parameter appears in the
Advanced Parameter page.

The Locked resources parameter is not available in the New Connection
wizard's Advanced Parameters page.

REVERSE_TABLE_WEIGHT parameter
in the Data Access Guide

In the in the Data Access Guide, in the PRM file configuration reference, the
information on theREVERSE_TABLE_WEIGHT parameter states the values
for specifying the manner in which tables are generated — from the largest
to the smallest, or smallest to the largest. This information is incorrect for
Oracle databases. That is, for Oracle databases:
• Y specifies that tables are generated from the largest to the smallest.

• N specifies that tables are generated from the smallest to the largest.

Note: TheOUTERJOINS_GENERATION parameter must be set to ANSI_92
for the REVERSE_TABLE_WEIGHT parameter to have any effect at all.
When the OUTERJOINS_GENERATION parameter is set to USUAL, the
REVERSE_TABLE_WEIGHT parameter has no effect.

RPT fileswithOracleODBC connections
This issue occurs with CR.NET or Crystal Reports only on Vista. In Windows,
RPT files opened and previewed using an Microsoft ODBC for Oracle
connection cause VS2005 or Crystal Reports to close and an error message
to appear.

Workaround:
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To enable the fix delivered with BOE XI R2 SP3 or to enable the shared
environment for specific ODBC drivers, you need to set the following registery
key:
[HKEY_LOCAL_MACHINE\SOFTWARE\Business Objects\Suite 11.5\Crystal
Reports\Database\ODBC]

or
[HKEY_CURRENT_USER\SOFTWARE\Business Objects\Suite 11.5\Crystal
Reports\Database\ODBC]
"ReuseEnvDrvNames"="msorcl32.dll"

Teradata driver Unicode settings for a
Solaris platform

On Solaris, the Web Intelligence Report server crashes while retrieving the
Unicode data.

The Unicode settings for Teradata ODBC access changed as of with Teradata
ODBC driver version 3.04. The description in the Data Access Guide is no
longer valid.

Refer to the following description:

Requirements: Teradata ODBC driver version 3.05.00.07 and later

To enable Teradata ODBC driver to work in UNICODE mode, set the
following:
• in the ODBC.INI file, add the parameter INAAppCodePage=106
• in the Teradata.sbo file add the parameter UNICODE with value UTF8:

<Parameter Name="Unicode">UTF8</Parameter>

OLAP Intelligence connection not
available with reverse proxy

InWindows, you cannot create a reverse proxy OLAP Intelligence connection
for InfoView. Reverse proxy is not supported with OLAP Intelligence.
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NopreviewofNCHARandNVARCHAR
in Netezza

In AIX, you cannot preview NCHAR or NVARCHAR data using a Netezza
ODBC driver.

Workaround: Use CHAR type if possible.
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Incomplete documentation about
scheduling events

In the "Scheduling Objects" chapter of the BusinessObjects Enterprise
Administrator's Guide, under "Scheduling an object with events", the
example does not clearly explain that a scheduled object based on an event
will run if the event is triggered before the end date of the instance.

BusinessObjects in 2-Tier mode session
disappears if report execution is longer
than WISESSION parameter

When, on a UNIX platform, BusinessObjects is open in 2-Tier mode and a
BusinessObjects report is run that takes longer to execute than the value of
the WISESSION parameter, the BusinessObjects session disappears from
the Administration Console.

Workaround

To prevent session timeout from occurring while the query is running, activate
Asynchronous Mode on the server side:
1. Open this file: <Tomcat installation folder>/webapps/wi

jsp/WEB_INF/classes/wstk_bridge.xml

2. In the file, for the bridge name HTTPJob, change the value of the
async_method name="Call" parameter from No to Yes.

Exporting a query to a TXT file results in
an unwanted decimal separator

In Windows, if you set the object format in the universe to '0' using Designer
and then save a query as a .txt file, '.00' is appended on the numbers in the
file. If the value is numeric then it is checked for a decimal point. If one is not
found then the value is appended with '.00'

Workaround:
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Using an database application, for example Access, change the object data
type to integer in the database.
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All REP sub-reports appearing in the
same PDF

In BO XI R2, when the the multiple tab REP document is viewed in PDF
format via InfoView, all the sub-reports are contained in the same PDF
document. The user must manually browse through each of the sub-reports,
make a note of the starting page and ending page of each sub-report, and
then in the Print dialog box enter the starting page and ending page of the
desired sub-report.

In BusinessObjects 6.5 each sub-report was created as a separated PDF
file, so the user could display the sub-report in the PDF viewer, then print it
without having to manually compute the number of the start page an the
number of the end page in order to print a particular sub-report.

Workaround:

To enable this feature do the following:

If you are using JSP:
1. Open the following file:

$[TOMCAT_INSTALL_DIR]\webapps\businessobjects\enter
prise115\desktoplaunch\WEB-INF\classes\webiviewer.properties

2. Add the line PDF_TabbedView=ON at the end.
3. Restart the Tomcat.

Note: To disable this feature, add the line PDF_TabbedView=OFF or delete
the entire line.

If you are using ASP:
1. Open the following file:

$(BO_INSTALLATION_DIR)\BusinessObjects Enterprise 11.5\Web
Content\Enterprise115\InfoView\Webi\viewer\Web.config

2. Add the following:
<appSettings><add key="PDF_TabbedView" value="ON"
/></appSettings>

3. Restart the Internet Information Services (IIS Admin Service).
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Note: To disable this feature, add the line PDF_TabbedView=OFF or delete
the entire line.
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Newwindow appears, despite the use of
the command sWindow=Same

Calling openDocument URL in the Java script function window.showModal
Dialog with option sWindow=Same causes an extra window to be created by
the parent window.

Workaround:

Add an sWindow parameter value of openDocument.

Sample code:
window.showModalDialog('http://localhost/businessobjects/enter
prise115/Infoview/scripts/opendocument.aspx?iDo
cID=651&sType=rpt&sWindow=ModalDialog','TESTWINDOW','help=no;min
imize=yes;maximize=yes;status=no;resizable=yes;scroll=yes');
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Search Indexing Program in InfoView

Updating the BIAR file

In InfoView, when you select the Search Program folder and schedule
Search Indexing Program, the following error message appears:

"The program failed to run and supplied the following information:
com.businessobjects.search.sdk.IndexResult.getFirstTs()Ljava/util/Date"

Workaround:

Using the Import Wizard, import the program object from the BIAR file found
at the following location:

\[Business Objects Enterprise installation directory]\BusinessObjects
Enterpprise 11.5\Samples\searchprogram.<lang>.biar

Updating the content search

After you install BO XI R2 SP3, the existing index for the Central Management
Console Content Search no longer works. You need to reset the index and
reschedule the Search Indexing Program option.

To do this:
1. In the Central Management Console, go toBusinessObjects Enterprise

Applications > Content Search > Properties.
2. Activate Reset index when the indexing program next runs.
3. Click Update.
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You can now access Information
OnDemand from InfoView

In the InfoView toolbar there is now a new button and link that opens
Information OnDemand.

Information OnDemand is an online store that gives you quick access to
prebuilt, customizable reports that let you compare your data with external
market and financial data.

By default the button and the link are inactive after installation.

To activate the button and link, add the following to [BOE XI R2 SP3 install
directory]BusinessObjects Enterprise 11.5\Web Content\Enter
prise115\InfoView\web.config:
<context-param>
<param-name>app.supportondemand</param-name>
<param-value>true</param-value>
</context-param>

For .net, add the following to businessobjects\enterprise115\deskto
plaunch\WEB-INF\web.xml.
<!-- Set to true to enable OnDemand Toolbar button -->
<add key="supportOnDemand" value="true" />

For more information on this product, refer to the following website:

"http://www.ondemand.com/information/default.asp"
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Web Intelligence help pages missing
Help pages are missing for some numbered Web Intelligence help pages
(for example WIS 10703).

Faulty cell display
Cell display is faulty when the Auto-height and Auto-width properties are set
and the "Read cell content as" setting is set to "HTML".

For User with administrator rights, View
SQL is disabled

For a user logged into InfoView as an Administrator, the View SQL option is
not available.

Workaround:
1. Log into the Central Management Console.
2. Go to Home > BusinessObjects Enterprise Applications >Web

Intelligence > Advanced Rights.
3. Set "View SQL" to "Explicitly Granted".

Drill up does not work in the Firefox2
browser

You cannot drill up in a Web Intelligence report in the Firefox 2 browser.

Workaround: Use the Java panel for drilling in reports. To do this:

In InfoView > Preferences >Web Intelligence Preferences under "Select
a default creation/editing tool" select Java Report Panel, and then OK.
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Drag and drop in reports does not work
in the Firefox2 browser

You cannot drag and drop variables or objects into a Web Intelligence report
in the Firefox2 browser.

Workaround: Use the Java panel for drilling in reports. To do this:

In InfoView > Preferences >Web Intelligence Preferences under "Select
a default creation/editing tool" select Java Report Panel, and then OK.

TheNoFilter functiondoes notworkwith
block or quick filters

In Windows, when you create the Web Intelligence report variable =NoFil
ter([Sales revenue]) In ([Year]) and apply a report tab filter, the
variable calculation is correct. However, when you use the block or quick
filter the Nofilter() function is ignored. This happens because NoFilter()
ignores all filters except Drill.

For information on using NoFilter for drilling, seeWhat's New in
BusinessObjects Enterprise Release 2 Service Pack 3.

No database ranking for HP Neoview
Web Intelligence does not support Database Ranking for HP Neoview.

The wrong error message appears when
a user without correct access rights tries
to schedule a Web Intelligence report

In Windows, when a user explicitly denied rights to access Web Intelligence
reports tries to schedule a Web Intelligence report, the following error
message should appear: "This user does not have access to schedule the
document"
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Instead, the following message appears: "Java.lang.Null pointer Exception"

Not able to retrieve a prompt while
rescheduling aWeb Intelligence instance
in History

Web Intelligence

Under UNIX, when you reschedule in History an instance of a Web
Intelligence report created in BO XI R2 SP3, the following error messages
appears:

Internal error occurred when retrieving prompts. Error:null.

Turning to a pie chart from a report with
more than ten objects crashes the report
server

Under Solaris, Linux or HP-UX, when you turn a table to a pie chart in a Web
Intelligence report that contains more than ten objects, the Web Intelligence
Report server crashes.

48 BusinessObjects Enterprise XI R2 Service Pack 3 Release Notes

Web Intelligence11 Not able to retrieve a prompt while rescheduling a Web Intelligence instance in History



Crystal Reports

12



Arabic does not appear correctly using
Oracle Client

Arabic characters do not appear correctly in Crystal Reports BO XI R2 SP3
when you use Oracle client 10.1 or 10.2. However they do appear correctly
when you use an Oracle ODBC connection.

BO XI R2 SP3 contains a fix for this problem. For it to work properly, you
need to make the following updates to the registry:
1. Set UseOSLocaleForConversion to YES and deactivate UseCustomCode

Page so that data is translated to Unicode.

2. Set UseOSLocaleForConversion to YES and set UseCustomerCodePage
to a code page number so that number is used to do the transfer.

If UseCustomerCodePage is 0, it uses the language as Unicode page. If
you set UseCustomCodePage to a non-number or an incorrect code page
number, data is translated to Unicode.

3. Set UseOSLocaleForConversion to NO or the no setting, so that nothing
is translated.

Unable to create a Crystal report after
deploying Adhoc.war application in
WebLogic application server

In a Linux environment, when you install BOE XI R3, deploy the Adhoc.war
application in WebLogic application server, and try to create a Crystal report
in a browser window, the following error message appears:

Compilation of JSP File '/mainframes.jsp' failed

For more information on this issue, referred to as CR282101 on theWebLogic
Server Known and Resolved Issues page, see
http://edocs.bea.com/wls/docs92/issues/known_resolved.html.

Workaround: Upgrade your version of WebLogic to 9.2 MP1 or higher.
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HPNeoViewproblems inCrystalReports
The following HP NeoView problems exist in Crystal Reports:
• Using an HP NeoView connection produces a memory read error when

reporting off NVARCHAR data type.

Do one of the following:
• Upgrade to NeoView version 2.2.
• Use the CHAR and VARCHAR data types instead of NVARCHAR.

• In Linux, a memory read error occurs if you use an HP NeoView
connection while trying to retrieve nchar or nvarchar data from database.

Workaround: Use the CHAR and VARCHAR data types.

• In Windows, a linking join between commands and tables using an HP
NeoView connection causes a failure to retrieve data from the database.
You can try to create links between tables, however you cannot link
between commands and tables.

• The SQL statements generated for record selection against a very small
number are not recognized by HP NeoView.

Workaround: Avoid selecting a small number, for example use 0.0 instead
of 0.0000000001, if 0.0 can meet the selection requirement.

• In Windows, Crystal Reports cannot show views when System Table is
activated in the ODBC administrator options for a HP NeoView ODBC
connection.

Workaround: If users want to see views through the HP ODBC driver, in
View > Options > Database, deactivate System Table.
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Analytics

Gauge analytics

When you manually define a range of values in a speedometer, these values
remain, even if you change the metric or sliced metric.

Analytics are not available using SharePoint 2007

When you try to open an analytic using Portal SharePoint 2007, an error
page appears instead.

Problemswith editing and viewing analyticswithout
IE6 SP1 patches

Installing JVM 1.4/1.5/1.6 and Internet Explorer 6 SP1 without any patches
results in the following:
• When you view an analytic and click the Edit link, a blank page appears.
• When you create an analytic, the Performance Management tabs and

sub tabs disappear.

You need to install the following Internet Explorer 6 SP1 patches:
• Q823353
• Q833989

Unable to create analytics based on a universe query
that uses the measures with BEGIN_DATE and
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END_DATE prompts over a HP Neoview 2.2
connection

When you create an analytic based onQuery on Universe that usesmeasures
containing the BEGIN_DATE and END_DATE prompts and where the generic
ODBC is based on HP Neoview 2.2, the following error message appears:

"Error while accessing data provider"

Workaround:

To use timestamps with analytics based on universe queries do one of the
following:
1. In Designer keep the column in the universe as a TIMESTAMP.
2. Edit the Where clause of the universe column.
3. Cast the DATE values to TIMESTAMP.

4. Change the column to DATE at the table level in database and avoid the
cast.

For example,

Initially, if the Where clause condition of the universe column is defined as:
DW_CAR_FACT.Order_Date_Id = DW_CAR_DATE.Date_Id
and DW_CAR_DATE.Period_Start BETWEEN @Prompt('BEGIN_DATE',
'D',,mono,free) AND @Prompt('END_DATE', 'D',,mono,free)

Change the timestamp to date using the following conversion in the where
clause:
DW_CAR_FACT.Order_Date_Id = DW_CAR_DATE.Date_Id
and CAST(DW_CAR_DATE.Period_Start AS DATE) BETWEEN
@Prompt('BEGIN_DATE', 'D',,mono,free) AND @Prompt('END_DATE',
'D',,mono,free)
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Applications

Deleting a subject from Set Architect causes errors
in the Performance Management repository

When you delete a set subject from set architect an entry remains in
CI_SUBJECT referencing the SET_SUBJECT row where this subject was
stored. This record was not deleted by Set Architect.

Workaround:

Refresh manually the subject list to get the updated subject list.

An HTTP 500 error in Performance Manager My
Goals

In Performance Manager, an HTTP 500 error occurs when you open My
Goals. This problem occurs if the Central Management Server (CMS) and
the performance management web parameters IP address have not been
properly configured.

For information on how to properly configure the CMS, see the
BusinessObjects Enterprise XI Release 2 Administrator's Guide. For
information on how to properly configure the performance management web
parameters, see the online help in the performance management Setup.

Set Analysis

Connectivity: Sybase ASE

When you try to build a set using Sybase ASE version 12.5, the error
message 'A problem occured while executing SQL statement' appears, and
the set is not created correctly. This problem does not occur with Sybase
ASE version 12.5.2.
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Connectivity: Netezza
• Netezza does not support constraint checks. Activating 'Omit Referential

Integrity' will not affect repository creation or hinder application
functionality. This option can be activated when you set up a new
repository or in the performance management Setup > Parameters.

• You must deactivate Use Transactions in the performance management
Setup > Parameters page otherwise you will have locking issues updating
set_sync within architect.

• Set Analysis only works with the Netezza ODBC 3.0 driver. Set Analysis
does not work properly with the 3.5 driver.

• Netezza operates with a single point of entry into the database. The
threads parameter within Set Architect has a default value set to 1.

PredictiveAnalysismodels do notworkwith Sybase
ASE 15

When you try to regenerate a model in Predictive Analysis with Sybase
ASE15, the following error message appears:

"An error occurred while saving data for the refresh model. Contact with your
Business Objects administrator."

PerformanceManagementdocumentation
• TheDeploying the Performance Management Framework guide contains

the following note for multiple application servers in a performance
management configuration:

"If you deploy Performance Manager, you cannot use multiple web
application servers."

This is no longer the case. The use of multiple web application servers
is now allowed when Performance Manager is deployed. For information
on deploying different server instances on different machines, refer to the
section on multi-node deployments in Deploying the Performance
Management Framework.

• A decimal point was omitted in the Deploying the Performance
Management Framework guide. The guide should read as follows:
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• Under Configuring Performance Management on WebLogic

step 2

CLASSPATH=<BO Installation Dir>\BusinessObjects Enterprise
11.5\java\applications\cewcanative.jar

step3

Locate the desktop.war file found at <BO Installation
Dir>\BusinessObjects Enterprise 11.5\java\applications.

• Under Setting Daf.configdir

step 2

Copy the InitConfig.properties file found in <BO Installation
Dir>\Performance Management 11.5 to the folder c:\config
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Designer SQL generation parameters

Inner joins in WHERE clause

When the universe parameter ANSI92 is set to yes, a new parameter,
INNERJOIN_IN_WHERE, allows you to force the system to generate SQL
syntax with all the inner joins in the WHERE clause. This is only possible if
a query contains only inner joins.

In Designer, if the universe parameters INNERJOIN_IN_WHEREand ANSI92
are both set to yes, the system generates ANSI 92 join syntax in the FROM
clause except when the query contains only inner joins. In this case, the
inner joins go into the WHERE clause.

Self joins in WHERE clause

When the universe parameter ANSI92 is set to yes, the syntax for self-joins
is generated according to the ANSI 92 convention, and conditions for a
self-join go in the ON clause of the table join definition in the FROM clause
of the SQL query.

In Designer, if the universe parameters SELFJOINS_IN_WHEREand ANSI92
are both set to yes, the conditions of a self-join go in the WHERE clause of
the SQL query.

By default, the SELFJOINS_IN_WHERE parameter is set to no.
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Users are not allowed to view Voyager
documents in InfoView

Users see Voyager document titles in InfoView but do not have links to the
documents. Users can add these documents can be added to My Dashboard
pages.

When a Voyager workspace is saved to a public folder, it inherits the default
rights of "Schedule". To let others view the workspace, the administrator
needs to select "custom" rights and explicitly grant the "Edit object" rights
in the Central Management Console properties.
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Error when trying to open a report from
an encyclopedia link

In Windows, When you open a document using BusinessObjects in 3-tier
mode from a Business Question encyclopedia link, an internal problem error
message appears.

Reports do not reflect InfoView
preferences

Desktop Intelligence, Web Intelligence or Crystal reports opened from a
Business Question encyclopedia link do not follow the preferences set in the
InfoView preferences.

For example, even if the document viewing preference is set as "in a single
full screen browser, one document at a time", a report opened using the
encyclopedia link is not opened in a full screen browser. It opens in the
InfoView portal.
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In Live Office, you cannot create folders
directly under the BOE Public folder

While saving a Live Office document, the Create New Folder button is
disabled after you select Public folder.

Workaround: If you need to create a folder directly under the BOE Public
folder, do it through InfoView.
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WorkingwithDrill: Handling document
reference in the CallbackScript

In the previous releases of Web Services, while drilling a document, a null
value was passed as a document reference to the callbackscript, and a
workaround was implemented to get the document reference. In BO XI R2
SP3, the null values are no longer passed as a document reference to the
callbackscript and hence the workaround can safely be omitted.

Example: Passing the drill parameters to the CallbackScript

DrillOption objDrillOption = new DrillOption();
objDrillOption.setCallbackFrame("view");
objDrillOption.setCallbackScript("manageDrill.jsp");
objDrillOption.setAmbiguousDrillCallbackScript("ambigu
ous.jsp");
objDrillOption.setBlockHolder("block");
objDrillOption.setFromHolder("from");
objDrillOption.setDrillActionHolder("action");
objDrillOption.setFilterHolder("filter");
objDrillOption.setToHolder("to");
objDrillOption.setHierarchyHolder("hierarchy");
objDrillOption.setDocumentReferenceHolder("documentReference");
In manageDrill.jsp (CallbackScript)
String reference=request.getParameter("documentReference");

68 BusinessObjects Enterprise XI R2 Service Pack 3 Release Notes

Web Services18 Working with Drill: Handling document reference in the CallbackScript



Auditing

19



New Auditing database 'document path'
event detail

The Auditing database contains an event detail that displays the 'document
path' of a given report or document. The document path shows the following:
• folder name
• folder location
• valid report or document name

Note: The document path does not appear in the Auditing reports.
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Troubleshooting HTTP 404 errors
You can receive the HTTP 404 error for one of the following reasons:
• The requested page was deleted in error. Check the deployment folder

of the web application to make sure that the requested page exists.
• The web application is not properly configured. Try to access other pages

in this web application. If there are other pages in this web application
that are not accessible, then there is a problem with the web application
configuration. Consult the web application deployment instructions to
check that the configuration files are valid, or redeploy the web application.

• A system setting is incorrect. For example, the memory limit was reached
or an ODBC DSN was not correctly configured. As a result, an exception
was thrown and the expected page was not generated. Check the web
server log or the web application log for error or exception records.

• An environment variable is not properly set. This environment variable
can be a system variable, or a variable defined in the web application
server. As a result, a required library or class cannot be found. Check the
web server log or the web application log for error or exception records.
Consult the web application deployment instructions to make sure that
all of the required steps were done.

• The web application is corrupted. Restart the web server. If the problem
still persists, re-deploy the web application.

• If the requested resource is a dynamically-generated web page with a
special extension name (for example, .cwr), the web server may not
handle the request because the corresponding application mapping is
not configured properly. Check the web server configuration.

• A related web application may not be deployed or properly configured.
Consult the web application deployment instructions to verify the
configuration of the web application.

• If the page worked previously, but then stopped working, a recent change
on the web server side may have negatively impacted this page or its
parent web application. For example, when an add-on web application is
applied on top of the existing web application, the original configuration
may be corrupted. Check for recent changes to the web server.

Resolving HTTP 500 errors
You can receive the HTTP 500 error for one of the following reasons:
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• A prerequisite component is not installed or properly configured. As a
result, an exception is thrown on the web server side. Check the web
server log or the web application log for error or exception records. Check
the web application deployment instructions to make sure that all required
components were installed.

• An environment variable was not properly configured. This environment
variable can be a system variable, or a variable defined in the web
application server. As a result, a required library or class can not be found.
Check the web server log or the web application log for error or exception
records. Check the web application deployment instructions to make sure
that all required steps were done.

• A security setting was not properly set. For example, a required system
user account was not set. Check the web server log or the web application
log for error or exception records. Check the web application deployment
instructions to make sure that all of the required security settings are
valid.

• The web applicationmay not be properly configured or it may be corrupted.
Restart the web server. If the problem persists, redeploy the web
application.

• If the page worked previously, but then stopped working, a recent change
on the web server side may have negatively impacted this page or its
parent web application. For example, when an add-on web application is
applied on top of the existing web application, the original configuration
may be corrupted. Check for recent changes to the web server.

• If the requested resource is a dynamically-generated web page with a
special extension name (for example, .cwr), the web server may not
handle the request because the corresponding application mapping is
not configured properly. Check the web server configuration.

• If the web server is Microsoft IIS, refer to the following article in the
Microsoft Knowledge base:http://support.microsoft.com/kb/311766
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Documentation and information services

Business Objects offers a full documentation set covering its products and
their deployment. Additional support and services are also available to help
maximize the return on your business intelligence investment. The following
sections detail where to get Business Objects documentation and how to
use the resources at Business Objects to meet your needs for technical
support, education, and consulting.

Documentation

You can find answers to your questions on how to install, configure, deploy,
and use Business Objects products from the documentation.

The Documentation Roadmap references all Business Objects guides and
lets you see at a glance what information is available, from where, and in
what format. View or download the Business Objects Documentation
Roadmap, available with the product documentation at the Online Customer
Support web site.

Online help and guides in Adobe PDF format are available from the product
Help menus. Where only online help is provided, the online help file contains
the entire contents of the PDF version of the guide.

Customer support, consulting and training

A global network of Business Objects technology experts provides customer
support, education, and consulting to ensure maximum business intelligence
benefit to your business.

Business Objects offers customer support plans to best suit the size and
requirements of your deployment. We operate customer support centers in
the following countries:
• USA
• Australia
• Canada
• United Kingdom
• Japan

Business Objects consultants can accompany you from the initial analysis
stage to the delivery of your deployment project. Expertise is available in
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relational andmultidimensional databases, in connectivities, database design
tools, customized embedding technology, and more.

From traditional classroom learning to targeted e-learning seminars, we can
offer a training package to suit your learning needs and preferred learning
style. For more information, contact your local sales office or the Business
Objects Consulting Services.

Useful addresses at a glance

ContentAddress

Information about the full range of
Business Objects products.

Business Objects product information
http://www.businessobjects.com

Information on Customer Support pro-
grams, as well as links to technical arti-
cles, downloads, and online forums.
Business Objects product documenta-
tion, including the Business Objects
Documentation Roadmap.

Online Customer Support and product
documentation
http://www.businessobjects.com/sup
port

Send us feedback or questions about
documentation.

Business Objects Documentation
mailbox
documentation@businessobjects.com

Information on how Business Objects
can help maximize your business intel-
ligence investment.

Business Objects Consulting Services
http://www.businessobjects.com/ser
vices/consulting/

Information on Business Objects train-
ing options and modules.

Business Objects Education Services
http://www.businessobjects.com/ser
vices/training
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